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DS6618

Brief Description
The digital camera “DS6618” is a slim and compact digital
camera no bigger than a business card and only 6 mm
thick, making it incredibly portable and convenient. And
the DS6618’s simple and straightforward controls make
it easy to take pictures and then download your digital
images to a computer.  The bundled “ArcSoft
PhotoImpression3.0” software on the enclosed CD-ROM
provides a range of functions that make it easy for you to
modify your images, create calendars or postcards and
print out what you have created on your printer.

Trademark Information
• AutobriteTM is a trademark of SMaL Camera Technologies,

Inc. of Cambridge, MA, USA.
• Microsoft and Windows are trademarks of the Microsoft

Corporation of the U.S. and other countries. Windows
is an abbreviated term referring to the Microsoft Windows
Operating System.

• Pentium is a trademark of Intel Corporation.
• Macintosh, Power Macintosh, iMac, Mac OS are

registered trademarks of Apple Computer, Inc.
• PhotoImpressionTM is a trademark of ArcSoft, Inc.
• All other company or product names are trademarks

or registered trademarks of the respective companies.

Package Contents

After purchasing this product, be sure to check that the
package contains all the items listed below.

User’s manual, Quick start guide

Camera
Soft case

Strap

USB cable CD-ROM

Every effort has been made to ensure that this product is
complete. If any items are missing from the package,
contact the store from which you purchased the camera.
Keep the camera packaging in a safe place as it will be
needed if you return the camera for repairs, etc.
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CARE
Keep the camera dry; if it gets wet, wipe it dry immediately. Use and store the camera only in normal temperature
environments. Handle the camera carefully; do not drop it. Keep the camera away from dust and dirt, and wipe it
with a damp cloth occasionally to keep it looking new.
If your camera is not performing as it should, take it to your local Oregon Scientific store for assistance. Modifying
or tampering with the camera’s internal components can cause a malfunction and might invalidate its warranty and
void your FCC authorization to operate it.

FCC Declaration of Conformity
This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,

including interference that may cause undesired operation.

The FCC Wants You to Know
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult your local Oregon Scientific store or an experienced radio/TV technician for help.
If you cannot eliminate the interference, the FCC requires that you stop using your camera.
Changes or modifications not expressly approved by Oregon Scientific may cause interference and void the user’s
authority to operate the equipment.
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Safety Notes
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6 7

To ensure that you use your camera correctly, read
these Safety Notes and your User’s manual carefully
beforehand. The warning given here provide important
safety information and should be observed at all times.

■ The icon shown below is used in this document
to indicate the severity of the injury or damage
that can result if the information indicated by
the icon is ignored and the product is used in
correctly as a result.

Z WARNING
This icon indicates that death
or serious injury can result if
the information is ignored.

Safety Notes Be sure to read these Safety Notes before using the products.

Z WARNING
• The enclosed disk is a computer CD-ROM. Never

attempt to play this disk on an ordinary music CD
player as it may produce extremely high noise levels
that could damage your hearing or your audio equipment.

• The camera is a precision instrument. Never attempt
to take this part apart. There is a serious danger of a
powerful electric shock.

• Do not drape the connection cord around your neck
or otherwise treat the cable carelessly as this could
result in suffocation.

• Do not look through the viewfinder at the sun or other
strong-light. This could damage your eyesight.

• Do not leave the camera in locations exposed to direct
sunlight as this could cause a fire due to the action of
the lens.

• Do not bring the camera close to a flame or throw  it
into the fire.

• Do not drop the camera or otherwise subject it to strong
impact.

• Do not immerse the camera in water.

• General Information
• Do not use the camera while you are walking, running,

driving or operating machinery. This can result in a
serious accident.

• Request regular internal testing and cleaning for your
camera. Build-ups of dust in your camera can cause
fire or shock.

• Do not use this device in aircraft or hospitals. The use
of this device in an aircraft or hospital can cause
malfunctions in the control devices used in aircraft
hospitals.

Notes on Using Your Camera Correctly
• Test Shots Prior to Photography
For particularly important photographs (such as weddings and
overseas trips), always take a test photograph and view the
image to make sure that the camera is functioning normally.

* Oregon Scientific assumes no responsibility for any
incidental losses (such as the costs of photography or
the loss of income from photography) incurred as a
result of faults with this products.

• Notes on Copyright
Images recorded using your digital camera system cannot
be used in ways that infringe copyright laws without the
consent of the owner, unless intended only for personal use.
Note that some restrictions apply to the photographing
of stage performances, entertainments and exhibits, even
when intended purely for personal use. Users are also
asked to note that the transfer of memory containing images
or data protected under copyright laws is only permissible
within the restrictions imposed by those copyright laws.

• Liquid Crystal
If the LCD is damaged, take particular care with the liquid
crystal in the panel. If any of the following situations arise,
take the urgent action indicated.
• If liquid crystal comes in contact your skin:

Wipe the area with a cloth and then wash thoroughly
with soap and running water.

• If liquid crystal gets into your eye:
Flush the affected eye with clean water for at least 15
minutes and then seek medical assistance.

• If liquid crystal is swallowed:

Flash your mouth thoroughly with water. Drink large
quantities of water and induce vomiting. Then seek
medical assistance.

• Handling Your Digital Camera
This camera contains precision electronic components. To
ensure that images are recorded correctly, do not subject the
camera to impact or shock while an image is being recorded.

• Places to Avoid
Do not use or store the camera in the following type of
locations:
• In the rain or in very humid, dirty or dusty places.
• Places subject to extreme temperature rises, such as

in direct sunlight or closed car in summer.
• Extremely cold places.
• Places subject to strong vibration.
• Places affected by smoke or steam.
• Places subject to strong magnetic fields (such as

near motors, transformers or magnets).
• In contact with chemicals such as pesticides or next

to rubber or vinyl products for long periods of time.
• Sandy places such as beaches or deserts, or places

where there is wind borne sand.

• Notes on Condensation
If the camera is carried suddenly from a cold location
into a warm place, water droplets may form on the
inside of the camera or on the lens (condensation).
When this occurs, switch the camera off and wait an
hour before using the camera.

• Cleaning Your Camera
• Use blower brush to remove dust from the lens, LCD

or viewfinder as these surfaces, and then wipe lightly
with a soft, dry cloth.
Leaving the lens extended for long periods can allow
dust to enter the camera’s viewfinder. However, this
does not affect the image.

• Do not scratch hard objects against the lens, LCD or
viewfinder as these surface are easily damaged.

• Clean the body of the camera with a soft, dry, cloth. Do
not use volatile substances such as thinners, benzine
or insecticide, as these may react with camera body
and cause deformation or remove the coating.

• Using the Camera Overseas
When traveling overseas, do not place your camera in the
check-in baggage. Baggage handling at airports may subject
baggage to violent shocks, and the camera may be damaged
internally even when no external damage is visible.

• Others
• To view the images you have shot, you will need a PC

that conforms to the hardware and software
requirements given in the table on P.12.

• You will need a printer to print out the images you
have shot.

• Oregon Scientific, Inc. assumes no responsibility
whatsoever for any damages or loss of revenue incurred
as a result of the deleting of data stored in the computer
memory due to a fault or any other cause.

Notes on the Battery
* This camera has a built-in lithium-ion battery. Always

observe the precautions given below.
• The built-in lithium-ion battery is not fully charged at

shipment and must be charged up before being used
(/P.19).

• Lithium-Ion Battery Features
• Lithium-ion battery loses its charge even when not used.

Charge the battery just before taking pictures (1 to 2
days beforehand).

• To ensure that your lithium-ion battery lasts as long as
possible, push the lens back in and switch the camera
off promptly when you are not using the camera.

• The number of available shots will be lower in cold
locations or at low temperatures. You can increase the
amount of power produced by putting the camera in
your pocket or another warm place to heat it just before
taking pictures. If you are using a heating pad, take
care not to place the camera directly against the pad.

• Charging the Battery
• This camera can be charged at ambient temperatures

between 0°C - +40°C and it takes approximately 2
hours to charge a fully depleted the battery.

• The lithium-ion battery does not need to be fully
discharged or exhausted flat before being charged.

• Battery Life
At normal temperatures, the battery can be used at
least 500 times.
If the time for which the battery provides power shortens
markedly, this indicates that the battery has reached
the end of its effective life. Please contact the store from
which you purchased the camera.

To prevent fire or shock hazard, do not expose the unit to rain or moisture.

•Disposing of This Product
When disposing of this product, do so in accordance with your local waste disposal regulations.

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN
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Nomenclature

Auto Power Off Function
The Auto Power Off function automatically switches
the camera off to avoid wasting battery power when
the camera is left unused for 30 seconds while
switched on.

* The Auto Power Off function does not operate when
a USB connection is being used.

• To take pictures after the camera has automatically
switched off (Auto Power Off), push the lens back
in and then pop it up again.

• If you intend to leave the camera unused for a long
period, push the lens back in and completely switch
the camera off.

Switching On

Press the lens pop-up button.

Switching Off

Push the lens back in.

Attaching the Strap

Attach the enclosed strap. When
using a commercial strap, check the
strength and other properties of strap.

2

Liquid Crystal Display (LCD)
Description

Number of Available Shots (1-101), etc.

Battery Status
z : The battery has ample charge.
x : The battery is approximately half charged.
c : The battery charge is low. Recharge the

battery as it will run out shortly.

(Flashes 5 times and the camera switches off.)
: The battery is exhausted. Recharge the

battery immediately.

* Avoid switching the camera on and off
repeatedly when the battery is low on charge.

Image Size B : 640 x 480 pixels
C : 320 x 240 pixels

Delete Mode

S : Deletes the last image shot
D : Deletes all the images

Beep Tone on

LCD

0

z

A

e

S

D

See page

P.18

P.17

P.19

P.20

P.20

P.20

GUIDE TO CAMERA OPERATIONS

1

Shutter button (P.18)

Viewfinder window

Lens pop-up button

Lens

Viewfinder (P.18)

Liquid crystal display (P.10)

l Beep tone on and off button (P.20)
A Image size selection (P.19) /
e Delete (P.20) button

Shutter button (P.18)

Strap lug

USB socket (P.16)

* Camera: Use the digital camera “DS6618” only.
Camera and PC: Connect the camera to your PC with the USB cable, and launch “Oregon Scientific Photo Album”.

PURPOSE

Switch on and off

Taking pictures

Connecting the
camera to a PC

Downloading
(Saving) images

Checking camera
images

e Deleting images

Charging the
camera battery

z Checking the
battery status

A Selecting the
image size

l Setting the
beep tone

INSTRUMENTS

Camera

Camera

Camera and PC

Camera and PC

Camera and PC

Camera

Camera and PC

Camera and PC

Camera

Camera and PC

Camera

Camera and PC

Camera

Camera and PC

HEADING, ETC.

Switching on and off

Taking pictures

Connecting the camera to
a PC

Downloading images

Downloading images
Displaying downloaded images

Deleting images

Deleting all images
Formatting

Charging the battery

Liquid crystal display

Modifying camera settings

Selecting the image size

Modifying camera settings

Setting the beep tone

Modifying camera settings

* Install the “Oregon Scientific Photo
Album” software beforehand (/P.12).

[Camera]/[Download images]

[Camera]/[Download images]
[View]/[List] [Thumbnails] [Slideshow]

To delete the last image you shot: S
To delete all the images: D
[Camera]/[Configuration]/ [Delete All Images]
[Camera]/[Configuration]/ [Format]

[Camera]/[Configuration]/ Battery Status

[Camera]/[Configuration]/ Resolution

[Camera]/[Configuration]/ Beep

See page

P.8

P.18

P.16

P.22

P.22
P.24

P.20

P.26
P.26

P.17

P.10

P.26

P.19

P.26

P.20

P.26
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14 15

INSTALLING THE SOFTWARE
Because this camera uses USB bus power to charge the battery, the software must be installed
beforehand.

■  Pre-installation Checklist

 Windows  Macintosh
• Compatible PCs : IBM PC/AT or compatible (models

with USB support as standard)
• Operating system : Windows 98 (including the second

edition), Windows Millennium
Edition (Windows Me), Windows
2000 Professional*, Windows XP
Professional*, Windows XP
Home Edition*

• CPU: 200 MHz Pentium or better
• RAM: 32MB minimum
• Hard disk space: 200MB minimum
• Other: A CD-ROM for driver and software installation

* Users of Windows 2000 Professional, Windows XP
Professional, Windows XP Home Edition should log
on under an Administrator account (e.g. “Administrator”).

• Compatible Macs : Power Macintosh G3 200 MHz
minimum (models with USB
support as standard)

• Operating system : Mac OS 8.6-9.0, 9.1, 9.2
• RAM: 32MB minimum
• Hard disk space: 200MB minimum
• Other: A CD-ROM for driver and software installation

Guide to Software

■ Oregon Scientific Photo Album

Page 14

Page 15

Page 21

Software for tasks such as downloading images you
have shot on the camera, checking and deleting the
downloaded images, and modifying the camera
settings. This software is also used when a TWAIN-
compatible application downloads images directly
from the camera.
• When you install “Oregon Scientific Photo Album”,

the camera driver and TWAIN driver are also
installed automatically.

* This software is needed to connect the camera to
your PC using the USB cable.

■ PhotoImpression3.0

Software to make it easy for you to download camera
images and modify them, create calendars or postcards.

* This software is TWAIN-compatible.

INSTALLING Oregon Scientific Photo Album
Do not connect the camera to your PC using the USB cable until the software
installation is completed.

* In Windows, you can install “Oregon Scientific
Photo Album” and “PhotoImpression3.0” in
succession.

 For Windows

Switch on your PC and load the enclosed CD-ROM.

The installer starts up automatically.

Install Oregon Scientific Photo Album.

* The camera driver and TWAIN driver are also
installed automatically.

Install PhotoImpression3.0.

When you click the [Finish] button, your PC is
restarted.

1

2

3

4

If you are finished to install,
[Oregon Scientif ic Photo
Album]’s short cut is displayed
on the desk top.

5

Point
■ Starting up the installer manually

Double-click [SETUP]
or [SETUP.exe] in the
CD-ROM window.

* The way file names are displayed dif fers as described
below depending on your computer settings.

• File extensions (3-letter suffers indicating the file type)
may be shown or hidden (e.g. Setup.exe or Setup)

• Text may be shown normally or all in uppercase (e.g.
Setup or SETUP).

You can select the softwares you want to install.

* Deselected software is not installed.

You can change the
installation destination
folder.

The screen on the left appears
in Windows 2000 and Windows
XP, but it has been confirmed
that installation can continue
without problems. Just click the
[Continue Anyway] button.

 For Macintosh Do not connect the camera to your PC using the USB cable until the
software installation is completed.

1

2

3

4

Switch on your Macintosh and load the enclosed
CD-ROM.

Double-click the CD-ROM icon, the [Oregon
Scientific Photo Album] folder and [Oregon Scientific
Photo Album] icon to start installation.

Click the [Continue...] button to start the installation.

Click the [Quit] button.

CD-ROM

Point

These files are installed on your Macintosh.

• [Oregon Scientific Photo
Album]’s alias:
On the desk top

• [Oregon Scientific Photo
Album] folder:
In your Macintosh’s hard disk

• [AXIADeviceDriver]
[TWAIN Data Sources]
[TWAIN Source Manager]
In the [Extensions] folder
inside the [System] folder on
your Macintosh’s hard disk

You can change the installation
destination folder.

The enclosed CD-ROM contains the software shown below.
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Point

CONNECTING THE CAMERA TO A PC
<Using the USB Cable>
Connecting the camera to your PC with the enclosed USB cable, you can charge the battery and
download your images to your PC.

Check that “Oregon Scientific Photo Album” software was installed correctly before connecting the camera to
your PC using the USB cable.

Switch the camera on and then connect it to your PC
using the USB cable.

When you connect the camera to a PC, “6” appears
on the camera’s LCD to indicate that the camera is
communicating with the PC.

* The PC switches to standby mode until it recognizes
the camera.

• Take care to connect the plugs on the
USB cable into the correct sockets, and
ensure that the plugs are inserted firmly.

• The Auto Power Off function does not
operate when a USB connection is being
used.

■ Connecting the camera to your PC with the USB
cable allows you to do the following:

• Charge the camera battery (/P.17)
• Download and display images (/P.22, 24)
• Modify the camera settings, delete images, format

the camera memory and reset the counter (/P.26)

z CHARGING THE BATTERY
This camera uses USB bus power to charge the battery. Before attempting to charge the battery,
install the software (/P.12) and then use the USB cable to connect the camera to your PC.

Charging starts automatically
when you connect the camera
to your PC with the USB cable.

Point
• It takes approximately 2 hours to charge a

fully depleted the battery.
• Number of available shots: Approx. 500

shots (when fully charged)

* This figure is an approximate guide to the
number of continuous shots that can be
taken at room temperature. The number
of available shots will be lower in cold
locations or at low temperatures.

Check that “Oregon Scientific Photo Album” software was installed correctly before connecting the camera to
your PC using the USB cable.

Try using the guidelines below to select the appropriate setting for your shot.
• B(640 x 480 pixels):

For images to be used in business documents (printed relatively small). For images to be used in files
used for presentations (displayed on a PC screen).

• C(320 x 240 pixels):
For images to be used via the Internet as an e-mail attachment, etc.

TAKING PICTURES

1

2

3

Switching the camera on.
• Focal range:

Approx. 60 cm to infinity.

Loading the strap over your wrist, brace your elbows firmly
against your body and hold the camera with both hands.
Compose your shot so that the subject you want to
photograph is within the field of view.

Point
The image will be blurred if the camera moves
when taking the picture (camera shake).
Take care to avoid camera shake, particularly
when shooting in dark locations.

When you press the shutter button, the camera
takes the picture.
The image is then recorded and the number in
the counter decreases.

At normal temperatures, the battery can be used at
least 500 times.

* If the time for which the battery provides power
shortens markedly, this indicates that the battery
has reached the end of its effective life. Please
contact the store from which you purchased the
camera. Battery must be replaced at the customer’s
expense.

About the Battery Life

Point
The counter flashes (rotates) during image
recording.

The DS6618 uses a CMOS sensor equipped with
AutobriteTM technology. This feature automatically
adjusts the exposure and captures the details in
scenes with bright lighting conditions, such as glare
or backlighting. Most existing digital cameras produce
washed out or silhouetted images under such conditions.

About the AutobriteTM Technology

Standard
Digital camera

DS6618

A SELECTING THE IMAGE SIZE
You can select the appropriate image size for your shots. The number of available shots varies depending
on the selected image size setting, and the number of available shots shown by the counter increases or
decreases accordingly.

About the Image Size

Select “B” for better image quality and “C”
to increase the number of available shots.

LCD File size
Number of

available shots

B 640 x 480 pixels 26 shots

C 320 x 240 pixels 101 shots

Point

Charging
the battery

Battery charge
has completed



E
n

g
lis

h

......................................................................................................................... .........................................................................................................................

......................................................................................................................... .........................................................................................................................

E
n

g
lis

h

E
n

g
lis

h
E

n
g

lis
h

20 21

22 23

The main window opens.

* You can change the “Oregon Scientific Photo
Album” settings in [Options].

* You can change the save destination folder for
the images.

e DELETING IMAGES
You cannot check images as you delete them, but you can use S to delete the last image you shot, or D to
delete all the images.

1 2

1

Holding down the e button for roughly 1 second
sets the delete mode to S/Delete frame.

Press the e button again to select D
(delete all frames).Point

Each time you press the shutter button, images
are deleted sequentially from the newest image.

Point
• When you select “S”, the newest frame

(frame 5 if you have taken 5 shots) is deleted.
Pressing the shutter button again deletes
frame 4, then frame 3, etc.

• You can delete all the frames at once by
selecting “D”.

• If you leave the camera in e delete mode
for 3 seconds without using the camera at all,
it automatically reverts to photography mode.

l SETTING THE BEEP TONE
You can select whether or not the beep tone sounds.

You can turn the beep tone on and off by pressing the l button.

* When “l” is displayed, the beep tone sounds.

USING Oregon Scientific Photo Album
You can use “Oregon Scientific Photo Album” software to download images in the camera to
your PC’s hard disk, check and delete the downloaded images, and modify the camera settings.

* This description shows the Windows screens, but the procedure is the same for Macintosh
computers.

Switch the camera on and then connect it to your
PC using the USB cable (/P.16).

* Charging starts automatically when you connect
the camera to your PC with the USB cable
(/P.17).

2

3

Double-click the [Oregon
Scientific Photo Album] to
launch “Oregon Scientific
Photo Album”.

You can select functions such as [Save As],
[Delete (Delete the files)], [Rename (Change
the file name)], [Rotate], [View (Change the
display format)] and [Configuration (Camera
Configuration)], etc. from the pull-down menu.

■ Delete the files
• Select the file you want to delete and

then select [Delete] from the [File] menu.

■ Rename the file/folder name
• Select the file/folder you want to rename

and then select [Rename] from the
[File] menu.

• Click the file/folder you want to rename
and then click again in the file/folder
name box.

DOWNLOADING IMAGES
You can download the images from the camera to your PC.

1 Select [Camera] / [Download images] from the
menu. 2 Click the [Start download] button to begin image

downloading.

Point
• When you connect the camera to a PC, “6”

appears on the camera’s LCD to indicate that
the camera is communicating with the PC.

* The PC switches to standby mode until it
recognizes the camera.

• The counter flashes (rotates) during image
downloading.

• If you cancel image downloading before
completion, downloading stops after downloading
of the current image is completed.

• The images in the camera are all downloaded
together. If you take more shots and then
download them without first deleting the images
you have already downloaded, the previously
downloaded images are downloaded again.

Point

Progress of image downloading

Overall download progress

* When the progress bar
reaches the right-hand end,
downloading is completed.

Number of downloaded images/
Total number of images in the
camera

Time until downloading is complete.

Total number of images in the
camera

When this checkbox is selected, the
images in the camera are deleted
when downloaded is complete.

Cancels downloading.
Start to download
the image

3 When image downloading is complete, the images are displayed as thumbnails.
☞  A folder named “(year)-(month)-(day)-(number)” is automatically created in the folder tree display area.

* If you download more images on the same day, the number automatically increments.

■  Thumbnail display window Menu

Point
Images are downloaded to the locations given below.

 Windows:
[Oregon Scientific]
folder on the local disk

 Macintosh:
[Oregon Scientific] folder
on the desk top

Folder tree
display area
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DISPLAYING DOWNLOADED IMAGES
Images downloaded to your PC can be checked, rotated and saved as new files under
different names.

1 2Select the folder you want to display in the folder
tree display area.

Select the display format from the [View] menu.

Displaying a frame enlarged    (/P.25)

• To view an image frame enlarged, select and then
double-click the file in the List or Thumbnail view.

• Select the frame containing the image file you want
to view enlarged and select [View] from the [File] menu.

Shows the file number.

Shows the image and the file number.

Opens the slideshow display window (/P.25).

■  Slideshow/Single-frame enlarged display window

Rotates the image right (clockwise)
in 90° increments.

* The modified image is saved
immediately.

Displays the
previous image

Rewinds to the
first image in the
photo album

Displays the next image

Fast forwards to the
last image

Starts the slideshow

* During a slideshow, this button changes to  .
Click this button to stop the slideshow.

* The slideshow plays continuously until it is stopped.

Sets the display time
for each image frame.

Saves the currently
displayed image as a new
file with a different name.

Rotates the image left (counterclockwise) in
90° increments.

* The modified image is saved immediately.

Closes the window

• About the file counter (file numbers)
File numbers (No. 0001 to 9999) are automatically assigned
to images when they are shot. The assigned file numbers are
then saved with the images during downloading.

* Because the file numbers assigned when shots are taken
are stored on the camera, the file numbers of images do
not change while they remain on the camera.

* If you delete an image on the camera after shooting it, the
file number of the deleted file is skipped.

* When you reset the file counter, the file numbers for the next
images shot begin again from “0001”. However,  the file
counter can only be reset when [Delete All Images] or [Format]
is selected in the “Oregon Scientific Config” screen.

• Low Light Alert: When this feature is enabled, the
camera warns the user that a scene is too dark for a
proper picture. Under such dim lighting conditions, the
camera will make an error beep when the shutter
button is pressed. Keeping the shutter button pressed
during and after the beep will force the snapshot, if
desired, but the quality of the picture will most likely
be sub-standard.

• Auto Shutoff timeout: User can select the auto shut-
off timeout with short (~25 seconds) or long (~50
seconds). The factory default is short.

MODIFYING CAMERA SETTINGS, DELETING ALL IMAGES,
FORMATTING, AND RESETTING THE FILE COUNTER
Camera settings can be checked and modified from your PC. You can also delete all the image
files, format the camera memory and reset the file counter (file number).

The “Oregon Scientific Config” screen opens and you
can perform tasks such as modifying the camera
settings and deleting all the data in the camera’s
memory.

Check that the camera is connected to a PC with
the USB cable (/P.16).

When the camera settings are modified in the
“Oregon Scientific Config” screen, the settings
on the camera are also switched automatically.

Point

Current file counter
setting (the file number
of the next image shot)

■ Oregon Scientific configuration screen

Image size
VGA : 640 X 480 pixels
QVGA : 320 X 240 pixels

Beep tone

Deletes all the images
on the camera.

Deletes all the data in
the camera’s internal
memory and formats
(initializes) the memory.

Number of images shot/
Number of available shots

Updates the screen to show the latest information on the camera.

* Clicking the [Update] button when you connect another camera
to the PC updates the screen to show the information for the new
connected camera.

Lockout the shutter
when low light

Auto Shutoff time
Short : 25 seconds
Long : 50 seconds

Battery charge level

Resets the file counter.

* The file numbers for
the next images shot
begin again from “0001”.

* Only available when
[Delete All Images] or
[Format] is selected.

Closes the window
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USING Oregon Scientific Photo Album as
TWAIN Driver
“Oregon Scientific Photo Album” allows images on the camera to be downloaded directly from the
camera using a TWAIN-compatible application such as “PhotoImpression3.0”.

1

Check that “Oregon Scientific Photo Album” software was installed correctly before connecting the camera to
your PC using the USB cable.

Switch the camera on and then connect it to your
PC using the USB cable.

• Take care to connect the plugs on the USB
cable into the correct sockets, and ensure
that the plugs are inserted firmly.

• The Auto Power Off function does not operate
when a USB connection is being used.

Point

2 Launch a TWAIN-compatible software application,
select the device and download your images.

Choose the [Oregon Scientific Digital Camera] to select
the “Oregon Scientific Photo Album (TWAIN Driver)”.

* The method for selecting the TWAIN driver differs
depending on the software you are using. If you are using
“PhotoImpression3.0”.

When “Oregon Scientific Photo Album (TWAIN driver)”
is selected, “Oregon Scientific Download” screen opens.

3 Click the [Start Download] button to download the
images.

Point

 For Windows only

The counter flashes (rotates) during image
downloading.

4 Select the images to be downloaded.

5 Click the [Transfer] button.

* You can also download images
using the [Transfer] button from the
[Twain] menu.

* Downloaded images are displayed
in the software.

6 Quit “Oregon Scientific
Photo Album”.

UNINSTALLING THE SOFTWARE
Only perform this operation when you no longer require the installed software.

 For Windows

 For Macintosh

1

2

Check that the camera is not connected to your
PC and then start up your PC.

Exit all application and programs.

Select the program you want to delete from
[Programs] in the [Start] menu and then select
[UnInstall].

3

Point
You can also uninstall the software using
[My Computer] / [Control Panel] / [Add/
Remove Programs Properties].

Even if you uninstall the software, the folder containing
your saved images (“Oregon Scientific” in the case of
“Oregon Scientific Photo Album”) is left untouched.

4

5

Select the [Remove] and click the [Next] button.

When the confirmation message appears, click
the button as directed by the on-screen instructions.

* The confirmation message differs depending
on the software you select.

1 2

3

Drag all the following installed files to the [Trash]. Restart your Macintosh.

Select [Empty Trash] in the [Special] menu.• The installed files for “Oregon Scientific Photo Album”
(/P.14)

•  The installed files for
“PhotoImpression3.0”
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No power. • The battery is exhausted. • Recharge the battery.

The battery runs out quickly. • You are using the camera in • Put the camera in your pocket or
extremely cold condition. another warm place to heat it.

No photograph is taken when • The Auto Power Off function has • Switch the camera on.
the shutter button is pressed. switched the camera off.

• The memory is fully recorded. • Download the images to the PC, and
delete some unwanted images.

The image is blurred. • The camera or subject was moving • Hold the camera firmly.
when the shot was taken.

• You are too close to the subject • Take the shot from a distance within
(outside the photography range) the photography range (approx. 60 cm
whenyou take the shot. to infinity).

• The pop-up lens is skewed. • Take care to pop the lens up correctly
so that it is not skewed.

Nothing happens when you • Camera malfunctions. • Switch the camera off and then on
use the camera buttons and again.
switch. • The battery is exhausted. • Recharge the battery.

TROUBLESHOOTING
Problem Cause Remedy

The PC does not recognize • Connect the camera to the PC • Connect the camera to the PC with
the camera. with the USB cable before installing the USB cable and select [My

the software. Computer] / [Control Panel]/
[System] / [Device Manager]. In the
[Device Manager] window, delete
[Compose USB device] or [Unknown
device] in [Other devices]. Then
disconnect the camera and install the
software before reconnecting the
camera to the PC.

• Connect the camera directly to the
PC using the USB cable, not via a
USB hub.

• Disconnect the other USB devices
connected to the PC.

Everything on the LCD • Camera firmware defect. • If the “Camera firmware is out of sync.
flashes and “7” or “8” is Update recommended. Update
displayed. firmware?” message appears when

you connect the camera to your PC
with the USB cable, click the [Yes]
button and update your firmware.

Problem Cause Remedy

• Actual number of pixels
0.31 million pixels

• CCD image sensor
CMOS image sensor with AutobriteTM technology

• Storage media
8MB internal flash memory

• File format
JPEG (Converted when images are downloaded using
the enclosed software.)

• Image file size
VGA: 640 x 480 pixels
QVGA: 320 x 240 pixels

• Sensitivity
Equivalent to ISO100

• Lens
F=3.8, f=6.87 mm
(Equivalent 47 mm on a 35 mm camera)

• Finder
Optical

• White balance
AutobriteTM

• Focal range
60cm - ∞

Specifications
• Shutter speed

Automatic (1/30 - 1/15000 sec.)

• Focus
Fixed

• Digital output
USB (mini-B)

• Number of available shots
VGA (640 x 480 pixels): 26 shots
QVGA (320 x 240 pixels): 101 shots

• Power supply
Lithium-ion battery (rechargeable, non-removal)

• Camera dimensions
85.6 x 54.0 x 6.0 mm (W/H/D)
(not including accessories and attachments)

• Camera mass(weight)
Approx. 1.2 oz. (35 g)
(including battery, not including accessories)

• Condition for use
Temperature: +32F to +104F (0°C to +40°C)
Humidity: 80% or less (no condensation)

* Specifications are typical; individual units might vary.
Specifications are subject to change and improvement
without notice.

■   For Windows
• Compatible PCs: IBM PC/AT or compatible (models with USB support as standard)
• Operating system: Windows 98 (including the second edition), Windows Millenium Edition (Windows Me),

Windows 2000 Professional, Windows XP Professional, Windows XP Home Edition
• CPU: 200 MHz Pentium or better
• RAM: 32MB minimum
• Hard disk space: 200MB minimum
• Others: A CD-ROM for driver and software installation

■   For Macintosh
• Compatible Macs: Power Macintosh G3 200 MHz minimum (models with USB support as standard)
• Operating system: Mac OS 8.6-9.0, 9.1, 9.2
• RAM: 32MB minimum
• Hard disk space: 200MB minimum
• Others: A CD-ROM for driver and software installation

System Requirements


